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 seq head2 \r0 \h Data Archive Utility

47.1
 seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Introduction

47.1.1
 seq head5 \r0 \h 

 seq head4 \r0 \h Overview

The Data Archive Utility XE "Data Archive Utility"  (DAU XE "DAU" \t "See Data Archive Utility" ) is intended to provide a simple, intuitive interface for archiving and retrieving data.  Designed with the Network Planning and Analysis System (NPAS) user in mind, the DAU adds special provisions for working with NPAS models and related files on top of a fully-functional archive utility complete with compression and search capabilities.  The DAU employs the UNIX tar utility to perform actual archive reading and writing, along with UNIX compress, gzip, and zip for compressing and uncompressing files.

47.1.2
 seq head5 \r0 \h 

 seq head4 \r0 \h Getting Started

The DAU relies on information stored in two locations to perform its functions.  The primary of these is the index directory where archive indexes are stored.  These indexes are text files listing the contents of your tapes.  By default this directory is set to ~/.dau.  When you first run the DAU, you are given the option to create this directory.  If you have used tape_lib, a Korn shell script, in the past and are migrating to the DAU, copy your existing archive indexes into this directory.  The second location, your .daurc file, becomes important when archiving NPAS models and related files.  From it, the DAU determines which files belonging to an NPAS model will be archived.  Manipulation of this file is discussed in paragraph 47.4.5.2.  You may either copy a provided version of this file or create your own within the DAU.  Before you begin you may also want to set your personal DAU defaults.  These may be set through a resource file, discussed in paragraph 47.6.2.  After setup is complete, execute the DAU by selecting File/Archive from the NPAS Menu.  It may also be run by typing run dau at the command line, provided the script directory of the NPAS installation directory is in your path.

47.1.3
 seq head5 \r0 \h 

 seq head4 \r0 \h The Main Window

The  XE "window:Data Archive Utility" topmost element of the DAU main window displays the program name and version.  Directly below that is the name of the currently loaded archive. This archive is usually located on a tape and is the sole archive on that tape.  The name of the tape, archive, and archive index all coincide. Next is the menubar,  which provides access to all the DAU’s functions.  Finally, the greatest percentage of the main window is occupied by a scrolled list containing the contents of the currently loaded archive.  See Figure 47-1.
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Figure 47-1.  DAU Main Window

47.2
  seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Options

The DAU XE "window:DAU Options"  has several options which affect its behavior.  All of them can be set via the DAU Options window (Figure 47-2), accessed by selecting Options/All.  Many options may also be set directly from the Options menu.

47.2.1
 seq head5 \r0 \h 

 seq head4 \r0 \h Index Directory

If you choose not to accept ~/.dau as your index directory, set it to whatever you like by typing it in the Index Directory field on the DAU Options window shown in Figure 47-2.  Also, you may alter your index directory by changing the directory in the process of loading an archive with the Load option of the File menu.  The toggle at the bottom of the DAU Options window labeled Automatic index generation determines what happens after an archive function is completed.  If the option is on, your tape will be scanned and a new archive index created.  If, however, it is off, the corresponding archive index will not be updated to reflect the new tape contents.  It may be useful to turn this option off when performing different archive functions on the same tape.  For example, if models were being archived as well as normal everyday files, you would not have to sit through two scans of the tape with this option off.  You will be reminded by the DAU to update the tape, before exiting the program or loading a new tape.  If for some reason, you choose a no-rewind device as your storage device, this option will automatically be inactive.  The tape will have to be rewound to the beginning of the archive outside the DAU before an index can be created.



Figure 47-2.  DAU Options Window

47.2.2
 seq head5 \r0 \h 

 seq head4 \r0 \h Storage Device

The storage device, usually a tape drive, may be set by typing the device path in the Storage Device: field in the DAU Options window. If your system administrator has supplied a file containing all the devices available to you, the Storage Device: button on this screen will access it and present you with a list to choose from.  If the list is blank, see your system administrator or create your own tape listing (paragraph 47.6.1).  The Storage Device option under the Options menu also presents this list.
47.2.3
 seq head5 \r0 \h 

 seq head4 \r0 \h Path Options and Base Directory

These options are crucial to the archiving process.  Pay special attention to what follows, as you need to understand the implications of these options.  Haphazardly setting these options may result in disappointment and frustration.

The path option may be selected with either the toggles under the Options menu or on the DAU Options window.  The path option set when archiving a file affects that file’s location upon retrieval.  When retrieving, the setting for this option is completely ignored.

There are three path options: absolute, relative, and no path.  The first, absolute, is the most dangerous. Consider a single file with the path, /usr/jdoe/stuff/file.txt.  With the absolute option, this file is archived to tape with that complete pathname.  Now, say you want to retrieve the file, this is the dangerous and usually frustrating part.  Suppose in the time since you archived this file, you modified it.  Now you want to refer back to something in the old version.  Unfortunately if you retrieve the file, the old version will overwrite the newer one.  Of course, if you are dealing with a small number of files, this can easily be remedied by copying the new versions to a different name and retrieving the old versions.  If, however, entire directory structures are being retrieved, this supposed cure is a sizeable pain.  A much better solution would be to have picked the relative path option when you were archiving those files.  Since we are being hypothetical, we can turn back time at a mere whim, but if you are actually in this situation (which you shouldn’t be, because I just warned you, and the DAU protests when using the absolute path option), see your system administrator.

When using the relative path option, there is another option you must be concerned with: the base directory.  The base directory may be set with the Base Directory option under the Options menu or in the appropriate field in the DAU Options window.  Let’s archive the same file as before, except now with the relative path option.  The file will be archived with a path name relative to the base directory.  In this example, say we set the base directory to /usr/jdoe. The file will be archived as ./stuff/file.txt.  The base directory also comes into play upon retrieval.  The location of the retrieved file will be relative to the base directory set at that time.  For example, if we now set the base directory to /usr/jdoe/other_stuff the fully-qualified path of the retrieved file would be /usr/jdoe/other_stuff/stuff/file.txt.

The final option, the no path option, is useful when directory structure is not needed.  In this case the base directory is also important, but only upon retrieval.  With this option all the files selected will be archived with only the filename.  In our running example, it would simply be file.txt.  When such files are retrieved, they are placed in whatever directory is the current base directory.
47.2.4
 seq head5 \r0 \h 

 seq head4 \r0 \h Compression Options

A method of compression may be selected via the toggles under the Options menu or on the DAU Options window. The actual compression and uncompression of files is performed by utilities separate from the DAU.  If a particular compression utility is unavailable, its toggle will be dimmed and inactive.  An archive which is compressed and moved to a system that does not have the appropriate compression utility will be useless.

Before files are archived to tape, they will be compressed with the selected method. Note that a file for which you do not have write permission cannot be compressed.  Furthermore, if you are compressing a directory with zip, you must have write permission to that directory’s parent directory.  

When retrieving these files, they will be identified by their suffixes: gzipped files ending in .gz, zipped in .zip, and UNIX compressed in .Z.  The DAU will ask you if you want the files uncompressed. Unlike tar, the compression programs used by the DAU are careful about overwriting files.  If you try to uncompress a file and an uncompressed version already exists there, the DAU will give the option to overwrite it or not. 
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47.3
 seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Working with Indexes

47.3.1
 seq head5 \r0 \h 

 seq head4 \r0 \h Loading an Index

Before anything can be written to or extracted from a tape, you must tell the DAU which tape you will be working with. One way to accomplish this is via the Load option under the File menu.  From the resulting selection box, depicted at the right, select an archive index and then OK or double-click the index name.  Put the tape in the tape drive, like the DAU says. Note that the only record of a tape’s identity is the writing on its label.  The DAU cannot determine a tape’s name from the tape itself.  The program relies on you to relay that information.  It’s critical that the loaded index and the inserted tape match.
If you intend to use a tape unknown to the DAU and it is blank or you do not care about its contents, proceed with an archive function, and the DAU will interrogate you, asking if you are sure about making a new tape and what the tape’s name should be.  You may type in an existing tape name at this point and it will load as with the Load option.  If you are interested in the contents of the unknown tape, create an index.

47.3.2
 seq head5 \r0 \h 

 seq head4 \r0 \h Creating an Index

If you have a tape with no corresponding index, you should use the Create Archive Index option under the Edit menu.  Using the key combination, Ctrl-I, will also work.  After you assure the DAU of your intent, the tape in the current storage device is scanned and a brand-spanking new index is placed in your index directory.  The new index is then loaded.

47.3.3
 seq head5 \r0 \h 

 seq head4 \r0 \h Removing an Index

If you rename, lose or retire a tape, you should remove its index from your index directory.  Do this by loading the useless index and selecting the Remove Current Index option under the Edit menu. Keeping these records up-to-date is essential if you want the DAU to accurately report the contents of your tape collection.  Manual deletion from the index directory with the UNIX rm command is another effective way of removing indexes.

47.3.4
 seq head5 \r0 \h 

 seq head4 \r0 \h Searching Indexes

As your tape collection grows, it becomes more difficult to keep track of its contents.  In order to combat this, the DAU allows you to search your entire collection for files matching a given regular expression.  Select the Search option under the File menu.  From the menu that pops into existence, pick the Archives... option.  Alternately, press Ctrl-S.  Type a regular expression in the window that pops up.  The results of a grep search using that expression will be displayed.  Browse the results, and select the file you were looking for.  Select the Load button.  The tape will be loaded and the selected file highlighted in the main window.

Since the Search Archives option in the DAU uses grep to search through your archive indexes, it is necessary that you be familiar with regular expressions.  These expressions can get a bit complicated, so only the most commonly used expressions will be discussed.

The simplest regular expression is a string of characters.  For example if you enter just gif, every file with that string anywhere in it will be listed, everything from gifford.txt to picture.gif.  To narrow it to your gif graphic files, a $ must be appended to regular expression.  A dollar sign matches the preceding regular expression to the end of the name.  Note that if you want to include the dot, it must be quoted with a backslash, so the final expression for searching for gif graphic files would be \.gif$.   The dot must be quoted because it is itself a special character in a regular expression, matching any single character.  This is generally not useful unless combined with the asterisk, which matches any number of the character that immediately precedes it.  Combining them into .*, matches any number of any character, behaving much like the lone asterisk shell wildcard.  For example, combining all you have learned, searching for schedule reports would require the regular expression, SCH_.*\.rpt$.
47.4
 seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Archiving

47.4.1
 seq head5 \r0 \h 

 seq head4 \r0 \h Overview

All of the DAU’s archive functions have been designed with a particular purpose in mind.  Although you may use them however you wish, it may be helpful to know the intended usage of the archiving functions to better determine how to fulfill your archiving needs.  First, the simplest of all, the Archive Directory function is geared toward backing up large amounts of organized data.  With it, entire projects organized under a directory can be copied to tape in case of unintended alteration or deletion.  Next, the Archive Files function, which assists in housekeeping your file system.  Use it to archive some of the clutter which may prove useful later, but is presently just wasting space.  Also, it may be used for keeping personal backups of scattered files.  The Search File System archive function can assist you if these files are so scattered that you have a hard time remembering their locations.  Finally, the Archive Models function is specifically designed to transfer NPAS models from one system to another.  It bundles the selected models along with the associated file types you choose and archives them.  When retrieved, the models are altered to allow them to be used on the new system.

47.4.2
 seq head5 \r0 \h 

 seq head4 \r0 \h Interface Layout

All of the DAU’s archiving functions have certain elements in common.  In the top line of each archiving window is a button labeled Current Tape: followed by a field displaying the current tape name.  By the time you reach any archive screen, a tape will have been chosen, either through the load option, or if nothing was loaded when you selected an archive function, a dialog box will ask you to enter the new tape name.  If you change your mind and want to switch tapes, type the new name in the field and press Return.  Pressing the button performs the same action as the Load option under the File menu.  The largest portion of each window is dedicated to displaying and selecting items to be archived.  At the bottom of each archiving window is a set of three buttons: Overwrite, Append and Cancel.  The Cancel button returns you to the main menu without archiving anything. The Overwrite and Append buttons come into play once you have selected items to be archived.  The act of overwriting replaces the tape’s contents with the new files, while appending places the new files after the existing contents.  The Append button is dimmed and inactive if a new tape is being used. 

47.4.3
 seq head5 \r0 \h 

 seq head4 \r0 \h Archiving a Directory

To archive  XE "window:Archive Directory" a directory, select Archive Directory... from the File menu or press Ctrl-D.  The window in Figure 47-3 pops up.



Figure 47-3.  Archive Directory Window

47.4.3.1
 seq head5 \r0 \h Selection

The field below the Current Tape: button labeled Directory displays the directory that is archived when either archive button, Overwrite or Append, is selected.  The contents of this directory are displayed in the window’s two lists.  The list at the right, labeled Files, contains all files found in the directory, while the left one contains all directories within the current directory.  Selecting a directory in the list labeled Directories changes the current directory to the selected one, updating the lists in the process.  The Files list provides a method for browsing the current directory’s contents.  The current directory may also be changed by typing a new directory in the Directory: field and pressing Return.

47.4.3.2
 seq head5 \r0 \h Compression

If you have chosen a compression method, the entire directory is compressed before it is written to tape.  If you are using gzip or UNIX compress, all directory contents will be replaced with compressed versions.  Then, the directory is written to tape.  After the archive completes, you are offered the option to return files to their original state or leave them compressed.  If, however, you are using zip, the entire directory will be placed into a single zip file and written to tape.  After archiving, the zip file will be removed and the directory will remain unchanged.  The internal structure of the zip file is such that if it is unzipped, the directory will be created in the same directory as the zip file.

47.4.3.3
 seq head5 \r0 \h No Path/Non-Zip Cases

Archiving a directory in the no path, non-zip cases behaves slightly different from the jdoe example used in paragraph 47.2.3.  In order to retain all the files within the directory itself, the directory name precedes all its content filenames in the archive index.  For example, the index after archiving the stuff directory would list stuff/file.txt rather than just the filename.  This way all the directory structure is preserved.

47.4.4
 seq head5 \r0 \h 

 seq head4 \r0 \h Archiving Files

Selecting  XE "window:Archive Files" Archive Files... under the File menu or pressing Ctrl-F displays the window pictured in Figure 47-4.



Figure 47-4.  Archive Files Window

47.4.4.1
 seq head5 \r0 \h Selection

Navigate through the directories as described previously.  When the files you want to archive are present in the Files list, add them to the Archive List by double-clicking or highlighting them and pressing the >> button.  To highlight a range of files click and hold the mouse button and drag the cursor, highlighting the files.  Alternately, select the file at the top of the range, scroll the list so the last file in the range is visible, and hold Shift as you click that file.  To select or deselect files without affecting other selections, hold the Ctrl key down while clicking.  To remove unwanted files from the archive list, double-click them or highlight them and press the << button.  After building the list to your satisfaction, press Overwrite or Append to begin the archive process. Note that if you only want to archive files from a single directory, the files need only be highlighted in the Files list when an archiving button is pressed.  This only works if the Archive List is empty.

47.4.4.2
 seq head5 \r0 \h Compression

If a compression method has been selected, all files up for archiving are compressed, replacing the originals with compressed versions.  After the archiving is completed and the index is created, the DAU checks the index to verify the success of the process, and the option is given to delete all, some or none of the archived files.  For any undeleted files the option is given to return them to their original uncompressed state.

47.4.5
 seq head5 \r0 \h 

 seq head4 \r0 \h Archiving Models

Archive  XE "model:archiving" 

 XE "window:Archive Models" models by selecting Archive Models... under the File menu.  An alternative is to press Ctrl-M. The Archive Models window (Figure 47-5) will pop up, which contains all the elements of the Archive Files window along with an extra model configuration option.  This configuration defines which files related to an NPAS model will be archived. 



Figure 47-5.  Archive Models Window

47.4.5.1
 seq head5 \r0 \h Selection

Select the Config: button to view a list of all the available configurations, select one and press Load. The selected configuration is displayed in the field next to the Config: button.  Build a list of models and press an archiving button.  The DAU will make a backup copy of the model file then modify the original in preparation for the transfer.  If you do not have write permission to the model file and the directory it is contained in, the model file cannot be backed up or altered, and the DAU will be unable to update the file locations in the model file when it is ultimately retrieved.  In this case, you will have to edit the file to make the model valid on the destination system.  Next, each model is placed along with the configured files into a file named for that model of the form model_name.tar.  Files for all the models in your list will be written to a temporary directory.  The contents of this directory will be written to tape.  The paths to all files will be hidden inside the tar archive, so you may want to make a note of the path option used.  If you are using the standard NPAS structure of storing models, usually the base directory should be set to the model directory’s parent (i.e. the study directory) and the path option to relative.

47.4.5.2
 seq head5 \r0 \h Defining a Configuration



Figure 47-6. Create/Edit Configuration Window

Create  XE "window:Create/Edit Configuration" a new configuration by selecting nothing in the Configurations list and pressing the Create/Edit button.  Type the new configuration name in the field on the Create/Edit Configuration window pictured at the right.  Select from the Model-related files list those files you want to associate with the new configuration.  Note that the selection of this list works differently than the other DAU lists.  Clicking an item toggles its value, affecting none of your other selections.  The All button, when selected, will toggle all items on, regardless of their status before pressing it.  If a configuration exists, which is almost what you need, select it and press Create/Edit.  The files associated with that configuration will be highlighted.  Change the name to something appropriate for the new definition and press Save.  If, however, you intend to replace the configuration, do not change the name.  The Remove button will delete the configuration listed in the field when it is pressed.  Configurations defined in this window will be saved in your .daurc file.

47.4.6
 seq head5 \r0 \h 

 seq head4 \r0 \h Archiving Search Results

In the DAU, there is an archive function XE "window:Archive Search Results"  which is not completely obvious.  It can be found tucked away in the File menu, labeled Search File System.... This function utilizes the find command to look for your files.  Find uses shell wildcards, which are summarized in Table 47-1. Enter a search ex​pres​sion containing shell wildcards in the Search Expression: field.  If, for example, you want to locate all your text files, enter *.txt and press Return. The entire file system within your base di​rectory is searched.  Match​ing files appear in the list.  Select the files you want to archive and, after you press Overwrite or Append, this function will behave like the Archive Files function.  See Figure 47-7.



Figure 47-7.  Archive Search Results Window

Table 47-1.  Shell Wildcards

Wildcard
Matches

?
Any single character

*
Any group of zero or more characters

[ab]
Either a or b

[1-9]
Any character in the range 1 to 9

47.5
 seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Retrieving

47.5.1
 seq head5 \r0 \h 

 seq head4 \r0 \h General Retrieving

To retrieve anything, load the index for the pertinent tape.  If you are not sure which tape the wanted files are on, search the indexes.  Select the items you want to retrieve from the listing on the main window.  See Figure 47-8.  Select consecutive files by clicking and holding the mouse button and dragging to the end, or select the first item and Shift-click the last item in the range.  Disparate items are selected by pressing Ctrl as you click them.  Now invoke the Retrieve Selected option under the File menu or just press Ctrl-R. 
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Figure 47-8.  Retrieving in the DAU

If you want to extract the entire contents of the tape, use the Retrieve All option under the File menu.  The files will be transferred from the tape to your file system.  Their respective locations will depend on the path option they were archived with and the base directory currently set.  

If any of the files end with .gz, .Z, or .zip, they will be listed in the window pictured in Figure 47‑9.  Choose to uncompress all, some or none of the files using the appropriate button.  If the uncompression will result in any files being overwritten, another window similar in form will allow you to overwrite all, some or none of those files.



Figure 47‑9.  File Expansion

47.5.2
 seq head5 \r0 \h 

 seq head4 \r0 \h Retrieving Models

If after uncompression any files end in .tar, the suffix used to identify files containing a model and its related files, another window will allow you to extract all, some or none of the retrieved tar files. After retrieval, model files will be modified to reflect the new locations of their related files.  

If a .tar file is compressed, and you tell the DAU to leave it compressed, it will never be identified.  You may still retrieve it by uncompressing it outside the DAU and setting the storage device to the file’s pathname.  The model file, however, will need to be manually edited to reflect the new file locations, otherwise it will be invalid.

The internal structure of the tar file will be invisible during the retrieval.  If you are unsure of the tar file’s contents, you may want to check it by retrieving it intact and viewing it with Xtar or executing a tar tvf on the file before extracting it.  If you make a habit of archiving models with relative paths and using the directory containing the model, dat, etc. directories as your base directory, you will not need to worry about this.

47.6
 seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Tailoring and Taming the DAU

47.6.1
 seq head5 \r0 \h 

 seq head4 \r0 \h Command Line Options

All the DAU’s command line options can be obtained by typing run dau -h at the command line. They will appear in the standard XIE out file, ~/.XIE_out. Aliasing the dau command to contain some of these options is a quick and easy way to customize the DAU.  Using resources, perhaps a more elegant method, is discussed in paragraph 47.6.2.  The command line options are described in Table 47-2.

Table 47-2.  DAU Command Line Options

Option
Operand
Description

-r

-i

-b

-t

-f

-m

-p

-c

-a/+a

-e/+e
integer

pathname

pathname

device path

pathname

pathname

option

option
Sets the number of rows in main window listing.

Sets the index directory.

Sets the base directory.

Sets the storage device.

Sets the location of the device file.

Sets the location of master model file.

Selects a path option (relative, absolute, or no).

Selects a compression method (none, gzip, zip, or compress).

Enables/Disables automatic index generation.

Enables/Disables exit confirmation box.

Three of the options listed here are inaccessible within the DAU.  The first, the -r option, sets the length of the archive index listing in the main window for that session.  The default is 10 rows.  Next is the -f option, which gives you the ability to change the location of that file containing all the available storage devices.  If your storage device selection list is blank, you can create your own file with devices and descriptions.  This file should contain a line for each device, beginning with the path on the left and ending with the description. The DAU only uses the string to the left of the first whitespace, so be sure the device path starts at the first character of the line and there’s at least one space before the description.  Other than that, go wild.  Once you have created this text file, alias dau to dau -f <file location>.  Finally, the master model file contains all possible model-related files along with a text description of each file.  In most cases you should just use the default.  This option is provided for emergencies only.  All these options may also be set with resources.

47.6.2
 seq head5 \r0 \h 

 seq head4 \r0 \h Resources

The following resources XE "resources:Data Archive Utility"  must be preceded by dau* in your resource file, whether its named npas in the directory defined by your LANG variable or its the .Xdefaults file in your home directory.  Color and font customization is not described, however, the relevant resources can be found in Volume 1.

Table 47-3.  DAU Resources

Resource
Values
Description

index_rows
positive non-zero integer
Sets # rows in main win.

index_dir
directory path
Sets index directory

base_dir
directory path
Sets base directory

arch_dev
device path
Sets storage device

dev_filename
file location
Sets device file location

master_model
file location
Sets reference model loc.

path_opt

RELATIVE/ABSOLUTE/NO_PATH
Sets path option

compress_opt
GZIP/ZIP/COMPRESS/NO_COMPRESSION
Sets compression option

confirmExit
TRUE/FALSE
State of confirm exit box

auto_index
TRUE/FALSE
Automatic index creation

The dev_filename resource is used to set the location of the file which lists all storage devices available to you.  See paragraph 47.6.1 for information on the format of this file.

47.6.3
 seq head5 \r0 \h 

 seq head4 \r0 \h Using a File as a Storage Device

Under certain circumstances you may want to break free of the DAU’s assumption that you are working with tapes.  Fortunately, that assumption is only superficial.  Suppose you download some new software contained in a tar file or you have chosen to retrieve your models still stashed away in their respective tar files.  Well, you are in luck. All you need to do is set the storage device to be the full pathname of that file, including the filename (e.g. /usr/jdoe/archives/model.tar).  Now, create an index for the archive, and give it a descriptive name.  Be sure to remove the index after you have deleted the tar file.

This trick can go the opposite way too.  You can archive to a tar file by setting the storage device to the path of the file you are creating or appending to.  This may be useful if you have a removable disk.  Set the storage device to a path located on that disk, and now you have access to all the NPAS-specific features of the DAU without the lethargic access time of a tape.  If you want to do this often you should probably add the disk to your device file.
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 seq head3 \r0 \h 
· This section contains information pertaining to NPAS Specific Schedule Event XE "database:Specific Schedule Event"  (SSE) processing outside of the standard Schedule process discussed in Volume 4.  In that volume, the creation of SSEs as schedule requests and their subsequent role in scheduling were discussed. Additionally, this section contains material describing processes involved in generating Network Control Center (NCC) Schedule Add Request XE "schedule add request"  (SAR) format data.  Specifically, the following options are discussed:

· Converting a file of NCC SARs to SSE format requests (Misc/SAR&SSE/Convert SAR to SSE).

· Generating NCC SARs from NPAS Schedule output (Misc/SAR&SSE/SAR File From Schedule Run), and viewing a report of the process (Reports/SAR File From Schedule Run).

48.2
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 seq head3 \r0 \h Converting SARs to SSEs

48.2.1
 seq head5 \r0 \h 

 seq head4 \r0 \h Introduction

The Misc/SAR&SSE/Convert SAR to SSE  XE "schedule add request:converting to SSE" option provides a simple and efficient method of converting NCC SARs to NPAS SSEs.  The process is designed to filter through non-SAR data until a SAR record is located. Once a SAR is found, the data elements of the SAR are examined.  SARs with invalid data for the given run parameters are discarded and the search for another SAR begins.  SARs with valid data for the given run parameters have their data transferred to a buffer, which will be dumped to SSE records at some point, and the search for another SAR record begins. The run parameters mentioned above include information contained in the NPAS NCC database, the DAS, and some user-supplied data given at run time.

48.2.2
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 seq head4 \r0 \h Inputs from SAR File

A SAR is a 600-byte character string that contains specifics of an event to be converted to an SSE which could later be scheduled by the NPAS scheduling process.  Files of SARs usually only exist for testing purposes.  These files usually only contain SAR records and no non-SAR records (as tapes often do).  However, these files can contain extremely intricate configurations of SARs that can be used to test the limits of the convert SAR to SSE process.

· Most 600-byte SAR records contain all the information necessary to describe the events to be scheduled.  Some SARs require the use of more than one SAR record to contain all of their services, but this facility in the convert SAR to SSE process remains untested. The SAR data fields that are of importance to the convert SAR to SSE process include the following:

· SUPIDEN.

· Station name.

· Event start time.

· Event start plus-tolerance.

· Event start minus-tolerance.

· Event duration.

· Prototype event code (if required).

· Number of configuration codes (or services).

· Each configuration code, relative start, and duration.

What is very important, however, is how this information matches up with what is in the DAS, the NPAS NCC database, and the user-supplied information.

48.2.3
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 seq head4 \r0 \h Output to SSE File

Each SAR that meets the defined requirements of the convert SAR to SSE process will be converted into SSE records and stored in the SSE database.  For each valid SAR, one SSE request with up to 18 services (each equivalent to a configuration code) can be created.  For SARs that request two-way tracking as one of their services, the convert SAR to SSE process will automatically break this into the appropriate two SSE services required to implement two-way tracking.

48.2.4
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 seq head4 \r0 \h Modeling Requirements

There are a number of elements within the user’s model that will make processing decisions regarding the input SARs.  Anyone who wishes to use the convert SAR to SSE process should know of these modeling requirements in order to understand why some SARs get converted, why others do not, and why some of the resultant SSEs look the way they do.

48.2.4.1
 seq head5 \r0 \h NCC/NPAS Correlation Data

a. This record  XE "database:Network Control Center" (called an NCC1 record) is the main controlling record for a mission in the convert SAR to SSE process as it contains the switch that invokes the process.  To edit this record, you must use the NPAS Record Editor, available from the NPAS Menu.  Load the NCC1 record type and advance to a blank NCC1 record.  Perform the following steps to prepare the record:

b. Set the record status, in field 1, to “ACTIVE.” 

c. Enter the NPAS mission number into field 7.

d. Enter the SUPIDEN into field 8.

e. If you want to retain the physical antenna specified by SAR, enter a “N” or blank into field 11.  If you want a 0 (zero) to be inserted  automatically in each service’s SSE antenna field for this mission, enter a “B” or “I” (or, “B” or “O” if using the SARGEN program) into this field.  Normally, you would want to enter a “B” here.

f. Enter a “Y” into field 14 to tell the convert SAR to SSE process to use this record.

Once you have completed editing the record, click on the Write button to save the data.

48.2.4.2
 seq head5 \r0 \h SAR Prototype Event and Configuration Codes

These records (called NCC3 records) are used in matching the configuration codes XE "configuration code"  or prototype events of incoming SARs and converting them to SSEs.  You may only edit this record by using the NPAS Record Editor and loading the NCC3 record type. Once you find a blank NCC3 record,  enter data into it as described  in the following record outline and discussion.

a.   An NCC3 record contains:

b.   Record Status. Field 1. Set to “ACTIVE.”

c.   NPAS mission number. Field 4.  This is optional; see the discussion following the record outline.

d.   SUPIDEN. Field 7.  Required.

1.   If you are using an NCC-defined prototype event:

2.   Three-character event code. Field 8. 

e.   Duration of the event. Field 9.

1.   NCC3-type services definitions. Fields 26 through 137.  Up to sixteen (16) services can be defined in each NCC3 record; multiple records can be used to define more services.  It is usually easiest to enter the service data by considering one service at a time (i.e., enter data into fields 26, 42, 74, 90, 106, and 122 for the first service, and so on).   Each service definition is referred to as an “NCC service.”  

(a) Service Type Designator. Fields 26 through 41.  This designator is a five-character string having the following format:

(b) First character. A  “R”, “F”, or “T” specifies whether this is a return, forward, or tracking service.

(c) Second character. A “N” or “C” specifies a normal or cross-support service.

(d) Third character. A “K”, “S”, “M” specifies whether the service is K-band, S-band or MA.

2.   Fourth and fifth characters. These two characters are digits that specify on which physical antenna the service should be scheduled.  Two zeroes in this field indicate that the service may be scheduled on any physical antenna that can support the service.

(a) Tracking Type. Fields  42 through 57.  If the service designator type specifies a tracking service, then in this field:

(b) “1” indicates one-way tracking.  Doppler is modeled on a return service. 

3.   “2” indicates two-way tracking.  Ranging is modeled on the forward service and Doppler on return.

4.   Data group, mode, and TDRSS Interface Channel (TIC). Fields 74 through  89. Optional.

5.   Datarate. Fields 90 through 105. Optional.

6.   NCC configuration code. Fields 106 through 121.  You would only use this field if you did not define a prototype event in field 8 of this record.  When combined with the above fields and the configuration option (below), this identifies a unique NCC3 service.

7.   Config. code option. Fields 122 through 137.  Enter arbitrary ASCII characters to make the service identified by the above NCC configuration code unique for the SUPIDEN/mission.  If you did not define a configuration code in the previous field, you should not enter anything in this field.

Before proceeding, we should further discuss uses of and relationships between the above fields.  First, every NCC3 record must contain a SUPIDEN. The SUPIDEN is the main key on which the records are searched and on which the records’ information is organized. Entering a mission number into this record is optional.  Since one SUPIDEN could be used by a number of different NPAS missions, a mission number here can be used to further organize configuration codes or prototype events under one SUPIDEN.  As an example of its use, consider that HST, which at one time was modeled using three different NPAS missions, would use one SUPIDEN in its SARs regardless of which NPAS mission was being used.

Input SARs can define their services either by using configuration codes or by specifying a prototype event.  If a SAR uses configuration codes, the SAR will detail service specifics (like start time and duration) following the configuration code.  For these types of SARs, one or more NCC3 records must exist for the SARs SUPIDEN, and every configuration code that could be used by the SAR must be defined here.  For each configuration code in the record, the service designation is the only requirement.  But if the service designation describes a tracking service, the tracking field must contain a “1” or a “2.”  Other fields could also be used to further define the configuration code, but their use is optional.

If the SAR defines its services instead by using a NCC prototype event code, then no service data will be given by the SAR.  Therefore, in order to accurately construct an SSE for the SAR, the services that are defined by the prototype event must be present in the NCC3 record. Additionally, SARs that specify prototype event codes are duration dependent, meaning that the event duration field (field 9) must be defined. This field will be compared to the event duration specified in the input SAR when it is processed.

If an NCC3 record is defined by both a SUPIDEN and a mission number, then any SAR represented by both the same SUPIDEN and mission number can only access NCC3 records that define the same SUPIDEN and mission number.  There is no “default” match.

48.2.4.3
 seq head5 \r0 \h Schedule Request Options

At least one SSE schedule request must be created for each mission that is to have SARs converted to SSEs.  The schedule request must specify the mission number and SUPIDEN of some active NCC1 record.  Also, the station list for the request must include all stations that might be requested by a SAR for the mission.  (Alternatively, if you prefer to use a single station specification instead of a station list, you must create multiple SSE schedule requests, one for each station.)  Finally, you must create a “dummy” SSE record that uses the desired SSE event code.  When the convert SAR to SSE process generates SSEs for the request, it will reference them using this code.  After the convert SAR to SSE process finishes, you will have to go in and manually delete the dummy SSE records.

48.2.4.4
 seq head5 \r0 \h Network Service Specification

The Network Service Specification window is used for defining the service type and antenna type for a service.  The service direction and type are specified in NCC3 records and are referenced by SARs using prototype events or configuration codes.   In convert SAR to SSE processing, the service type referenced by a SAR is compared with the service descriptions of the Network Service Specification.  If there is a match, then the service type will be copied into the SSE service type field for the service in the event.

48.2.4.5
 seq head5 \r0 \h Basic Station Data

A Basic Station Data window must be defined for each station specified by an input SAR.  The SAR to SSE process tries to match the three-character station name specified by the SAR with the three-character station name found in the SAR Name field in the Basic Station Data window.  This station name will also be referenced directly by the resultant SSE record.

48.2.5
 seq head5 \r0 \h 

 seq head4 \r0 \h Convert SAR to SSE Process Operation

Before running the convert SAR to SSE process, you should make sure that at least one NCC1 record that has a “Y” in field 14 (convert SARs to SSEs toggle) and “ACTIVE” in field 1 (record status) exists.  Convert SAR to SSE will attempt to convert all SARs that have the SUPIDEN referenced in this record.

To invoke the convert SAR to SSE process, select the Misc/SAR&SSE/Convert SAR to SSE option from the NPAS Menu.  A window, shown here in Figure 48-1, will appear requesting that you enter the name of an SSE file (called a “designator”) to which to add the SSEs.  
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Figure 48-1.  SSE File Selection 

Upon entering the designator, you will be requested to enter the projected start date of the SSE file.  No SARs will be accepted whose end time does not fall after this start date, nor whose start date falls greater than the mission model span length beyond this input date.  An example of the window in which you will enter this date is shown in Figure 48-2, below.  The format for the date is YYYYMMDD.  The Julian date will be computed automatically.  
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Figure 48-2.  SSE File Start Date Entry

Once you enter the date, the convert SAR to SSE process run parameters screen will be displayed as in Figure 48-3, below.  (If the screen “flashes” briefly and then shows nothing, holding the control key down and pressing the letter “r” should make the display reappear).  
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Figure 48-3.  Convert SAR to SSE File Name Entry

The names of the SSE and DAS files of the model are determined automatically by the program and shown in this window, however, the NCC file name must be entered manually.  You are presented with an option to extract the input SARs from a CCS tape or from a file.  The CCS tape option, however, is currently not supported, so you should not enter anything into these fields. (You may leave any automatically input data as it is.)  You should make sure that the SAR file name at the bottom of the display is accurate.  When done, press the return key to start the SAR to SSE conversion process.  A window similar to that shown in Figure 48-4 will appear.
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Figure 48-4.  SAR To SSE Conversion Interface

In this SAR to SSE Conversion Process display, all data relevant to the process is displayed throughout the conversion.  Also, all error and warning messages are displayed in this interface.  Some information shown in this window will not change over the course of the conversion.  These include the listing of some of the data given in the previous display: the SSE, NCC, DAS, and SAR file name (or SAR input device name).  The SSE file start date also remains unchanged in this display.

The data that changes most often is grouped together in a box on the left side of the display.   Included here is information relating to the current SAR being processed as well as overall SAR to SSE conversion process status.  Some of the conversion status information displayed relating directly to the number of SARs input includes the total number of SAR records processed and the total number of SAR records converted.  The former is a tally of both valid and invalid SAR records processed, and the latter counts every SAR record processed so far that was or will be converted into an SSE.  Other information relevant to SAR processing that is displayed here includes the total number of SUPIDENs processed and the total number of SUPIDENs converted.  The former is a tally of every different SUPIDEN read from input SARs, valid or invalid, and the latter counts every different SUPIDEN from each SAR that was or will be successfully converted into an SSE.  Three other status indicators shown include the SUPIDEN of the SAR currently being processed, the start date of the last SAR record processed, and a message called the “Transaction” that gives a brief summary of the convert SAR to SSE current state of processing.  All of these fields are updated repeatedly throughout the conversion process and you can use these indicators to monitor the process’s progress.

The arrays that are used to store the data to be converted to SSEs are dimensioned so that they can hold the data for fifty events at a time.  When fifty events have been stored in these arrays, or, alternatively, when there is no more SAR input, the data from the arrays is stored in SSE records.  When this occurs, you will see a transaction message saying that SSE records are being created and to please stand by.  When the data has been transferred to the SSE records, the convert SAR to SSE process resumes.

When the end of the input SAR tape or file is reached, the convert SAR to SSE process rewinds the tape, or closes the SAR file, and terminates, writing the remaining array transfer data to SSE records and returning to the SSE processing menu.

48.2.6
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 seq head4 \r0 \h Common Operation Errors

Listed below are problems commonly encountered by users when running the convert SAR to SSE process.  These problems usually involve incorrect or undesirable information in the NPAS DAS database.

48.2.6.1
Configuration Code Problems seq head5 \r0 \h 
One of the more frequently-made errors occurs when a configuration code XE "configuration code"  specified on an incoming SAR cannot be matched with one in an appropriate NCC3 record.  When this happens, an error message is displayed through the convert SAR to SSE interface display and the SAR is not converted.  What happens here is that the convert SAR to  SSE process searches through the NCC3 records having the same SUPIDEN as on the SAR and, if applicable, the same mission number as in the appropriate NCC1 record, and cannot find any NCC3 services for the input configuration code.  There can be many reasons why this might happen.  Usually, the service identified by the configuration code had been placed in an NCC3 record using the correct SUPIDEN but no mission number when another NCC3 record existed that contained a SUPIDEN and mission number appropriate to the input SAR.  In this case, you should check the NCC3 records to make sure the SUPIDEN and mission number keys on each NCC3 record as desired.  An NCC database report (which can be generated using the Submit/Reports/Model Reports/NCC Model option) is very handy here.  If the SUPIDENs and mission number keys look correct, then check original SAR prototype event and configuration code specifications to make sure the service should be in that particular NCC3.  If it is not supposed to be there, and it is not, then that SAR was not supposed to be converted.  If it is supposed to be there, and it is not, then the user should consider entering it into the appropriate NCC3 record for the SUPIDEN and/or mission.

48.2.6.2
NCC  seq head5 \r0 \h Prototype Event Code Problems

Sometimes a SAR will specify a prototype event code that the convert SAR to SSE process cannot find in any appropriate NCC3 records.  A warning will be displayed if this occurs that gives an explanatory message which includes the SUPIDEN and prototype event code of the SAR.  The reasons why the prototype event code could not be found are the same as the reasons why a configuration code might not be found.  In particular, either the NCC3 key values (SUPIDEN and/or mission number) are not defined correctly, or the code was never entered into an NCC3, or the code was not supposed to be in an NCC3 record at all and the convert SAR to SSE process was correct in discarding the SAR.  Since the prototype event code for the SAR was not found,  this SAR will not be converted, and processing will continue with the next SAR input.

48.2.6.3
 seq head5 \r0 \h Too Many Services In SAR

A SAR can have no more than sixteen services.  NPAS allows SSEs to have up to eighteen services.  The extra room for services is needed when converting the SARs as the convert SAR to SSE process will split two-way tracking services into two separate services.  Although this has only rarely occurred,  it is possible that a SAR can contain enough services and two-way tracking services to exceed the service number limit for an SSE event.  If this occurs, a warning is displayed that gives an explanatory message and the SARs SUPIDEN and start time.  Also given is the SARs number, which is the same number that appears in the “Total # of SARs Processed” field in the SAR conversion interface.  Since the number of services required by the SAR event exceeds the maximum allowable number of services in an SSE, that SAR will not be converted and processing will continue with the next SAR.

48.2.6.4
 seq head5 \r0 \h Network Service Specification Not Found

A network service specification subtype warning will be displayed if a network service specification to represent a SAR service designation cannot be found.  The warning prints out a message and the SARs SUPIDEN and service designation to the screen.  If this occurs the user should update the network service specifications (reachable by selecting Service/Edit from the Model Tool).  Any SARs having service designations like the one displayed will not be converted to SSEs and will be passed over without warning.

48.2.6.5
 seq head5 \r0 \h Requested Station not Found in Station Standards

A warning will be displayed if a SAR requests a station to be scheduled but the convert SAR to SSE process can’t find the station in the SAR Name field of any Basic Station Data windows. The warning prints a message and the SARs SUPIDEN and the requested 3-chartacter SAR station name.  At this point, you will be given the option of aborting the convert SAR to SSE process altogether.  If you choose to continue with the conversion, this SAR will not be converted, and any future SARs encountered that request this station will be passed over with no warning messages displayed. If this error occurs, the user should check to see if the requested station is supposed to be in the SAR Name field of some station in the model. If the station name is not supposed to be, you should discard the message and continue with the convert SAR to SSE processing.

48.2.6.6
 seq head5 \r0 \h Number of Services in SAR Conflict

A warning will be displayed if the number of services that are present in a SAR event does not equal the number of services value stored in the SARs “number of services” field.  If this error occurs, this means there is a problem with the current SAR and processing will continue using the actual number of services in the SAR event.

48.3
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 seq head3 \r0 \h Creating a SAR File From a Schedule Run

The process of generating XE "schedule add request:generating”  a SAR file from a Schedule run (called “SARGEN” for short) is invoked by selecting Misc/SAR&SSE/SAR File From a Schedule Run from the NPAS Menu. SARGEN reads data from the Schedule program output to create NCC-format SARs.  In addition to basic service information, plus and minus tolerances for each SAR can be computed and included in the SAR.

To use SARGEN, you will want to set up your NCC database similar to if you were running the convert SAR to SSE process.  That is, you will have one NCC1 record for each SUPIDEN/mission number combination for which SARs will be generated, and NCC3 records will exist to define associations between NCC configuration codes (or prototype event codes) and NPAS service types.  One difference in how you model an  NCC1 record is that in field 13, you will enter a “Y” if SARGEN is to be run on the mission.  Additionally, if you want to automatically generate plus and minus tolerances for SARs generated for the mission, enter a “Y” into field 12 in the NCC1.  Other than that, set up your NCC1 record as you would for the convert SAR to SSE process, as described in paragraph 48.2.4.1.

For the most part, setting up NCC3 records is done in the same way as was done for the SAR to SSE process, and is discussed in paragraph 48.2.4.2.  There is one more consideration, however, when setting up an NCC3 to be used by SARGEN, and this involves the data group, data mode, and TIC fields of an NCC3 service.  The main usage of these fields (data group/mode, TIC, datarate) in the NCC3 record is to match the NPAS scheduled services with the proper record’s configuration codes.  Internally, SARGEN will construct a string consisting of a service’s scheduled station. service direction, physical antenna, and so on, and uses this data to pick an NCC configuration code from the record.  In doing this, it compares that string of data with the string of data that makes up the service definition fields (of course, excluding the configuration code) in an NCC3. Since many of these service definitions are identical if you do not include the different configuration codes, the two-character field “Config Code Option” (fields 122 through 137, one for each of the sixteen NCC3 services) is used to make the service definition strings unique.

One thing to note is that SARGEN is not an interactive process.  Once the SARGEN run has completed, a window will pop up to allow you to view the SARGEN process report.  If you want to read the report at that time, select the View Report Now button; otherwise, select the Done button.  Note that you are able to view the report at a later time, regardless of what option you chose in the previous window.

The name of the file of SARs produced by SARGEN will have the prefix “SRGN_”, which will be followed by the name of the DAS, and will have suffix “.sar”.  This file will be stored in the “dat” directory appropriate to the model.

48.4
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 seq head3 \r0 \h Viewing the SAR Generation Process Report

In addition to a file of SARs, SARGEN produces a file reporting on the results of the process. This file can be viewed by selecting the Reports/SAR File From Schedule Run option from the NPAS Menu.  An example of this file is shown below in Figure 48-5.

                                       *****************************************************

                                       *                                                   *

                                       *               NPAS SAR GENERATION                 *

                                       *                                                   *

                                       *            VERSION 3.25  14JUN96 1400             *

                                       *                                                   *

                                       *    LIMITS: 199 MISSIONS,  960 SCHEDULE PERIODS,   *

                                       *    UNLIMITED VISIBILITIES & FLAGS  PER MISSION,   *

                                       *    3200 SERVICES PER MISSION, UP TO 300 ENTRIES   *

                                       *    PER MISSION,  99 STATIONS WITH UP TO 10 ANT-   *

                                       *    ENNAS  PER  STATION,   OVERALL MAXIMUM OF  0   *

                                       *    ANTENNAS PER RUN, MAXIMUM OF 20 ANTENNAS PER   *

                                       *    MISSION OVERALL,  MAXIMUM OF  30000 SERVICES   *

                                       *    ACROSS ALL STATIONS,  AND 2000 MAXIMUM TOTAL   *

                                       *    ENTRIES.  LOGIC SUPPORTS SPECIFIC SCHEDULING   *

                                       *    EVENTS                                         *

                                       *****************************************************

                                                       STANDARD ANALYSIS

                                                SPAN (IN DDHHMM FORMAT)=  70000

*** PERFORMING FINAL NCC SAR GENERATION & REPORTS

*** NO MISSION-ONLY DATA AVAILABLE FOR MISSION#= 7

FOR MIS. # =  7 NAME = ACE          SUPIDEN = A0007MS TOTAL OF    7 SAR EVENTS GENERATED

*** NO MISSION-ONLY DATA AVAILABLE FOR MISSION#= 52

FOR MIS. # = 52 NAME = ADEOS-1      SUPIDEN = A0052MS TOTAL OF   83 SAR EVENTS GENERATED

Figure 48-5.  SARGEN Process Report

Generally, this file will contain error messages incurred by the SARGEN XE "report:SAR Generation"  process; in addition, this file will report on how many SARs were generated for each SUPIDEN/mission number combination.
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 seq head2 \r0 \h Mutual Interference

49.1
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The Submit/Schedule Analysis/Mutual Interference  XE "mutual interference" \b 

 XE "Mutual Interference process" \b option of the NPAS Menu is used to assess the impact of mission-mission interference in a schedule run. When two missions are being simultaneously supported by a station there is the potential for interference.  Whether the services will interfere depends on their known interaction and the angular separation of the missions from the supporting station’s point of view.  The Mutual Interference program reports the impact of this type of interference on individual missions and the schedule as a whole. This program is limited to processing return services.
49.2
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 seq head3 \r0 \h Modeling

For interference to occur, services known to conflict must be scheduled simultaneously on the same station, and missions requesting those services must be within a certain angular separation.  Consequently, preparing a model for this analysis requires both coverage and schedule modeling.

49.2.1
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 seq head4 \r0 \h Separation Angle Events

On the coverage side, events XE "coverage event:separation angle"  must be calculated which correspond to all times during which a pair of missions are separated by less than a critical angle. In order for these coverage events to be calculated, separation angle requests must be created. The procedure for modeling these requests is discussed in the separation angle coverage modeling portion of Volume 3, Coverage Analysis.  

Throughout this type of analysis, individual missions may be referred to as primary or secondary.  The primary mission is the one being interfered with, while the secondary mission is causing the interference.  It is really a matter of perspective.  Suppose the shuttle’s return signal experiences interference when the Hubble space telescope is within 3 degrees of separation and is transmitting to the same station.  Conversely, the space telescope’s return signal experiences interference when the shuttle is within 6 degrees of separation and is transmitting the offending signal.  Consider the situation where the shuttle and Hubble are separated by four degrees.  If you consider the shuttle the primary mission, there is no interference.  On the other hand, if Hubble is considered the primary mission, there is interference.

For each mission included in the mutual interference analysis as primary, a separation angle request must be created for each potentially interfering (secondary) mission and supporting station combination. All separation angle requests for this type of analysis should reflect an exclusion schedule option and the angle apex at the station. Also, the secondary mission should be an actual coverage mission, not a sun event.

49.2.2
 seq head5 \r0 \h 

 seq head4 \r0 \h Link Modeling in Schedule Requests

Standard NPAS services do not contain specifications for datarates, frequency and polarization, which are necessary for mutual interference processing.  Consequently, these attributes must be modeled in all schedule requests containing potentially conflicting services.  This may be done through a Prototype Event (PE) or datarate table, although using a PE is recommended.  For the PE method, values are entered in the service’s Communications Loading Parameters window.  The relevant portion of this window is shown in Figure 49-1.
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Figure 49-1.  Mutual Interference Modeling in the CLP Window


Setting the I- and Q-channel datarates simply requires entering the values in units of megabits per second (MBPS) into the appropriate fields.  Frequency is defined using a 1-character code, and polarization is defined using a pull-down menu.  Because Mutual Interference is designed to interface with applications external to NPAS (e.g., CLASS), only certain combinations of frequency and polarization codes are permitted. Table 49-1 lists valid frequency codes, and Table 49-2 lists valid polarization options for this application.  Note that these polarization options are those associated with current TDRSs. 
Table 49-1.  Valid Frequency Codes

Frequency
Service
Frequency Description

M
MA
2287.5 MHz 

S
SSA
2287.5 MHz, Left Circular Polarization, MA Compatible

1
SSA
2287.5 MHz, Right Circular Polarization, Non MA Compatible

2
SSA
2217.5 MHz 

3
SSA
2255.5 MHz

K
KSA
15003.4 MHz

Table 49-2.  Valid Polarization Options for Mutual Interference

Polarization Option
Polarization, Link Type
Separation Angle File Code

Left, Low-Gain
Left Circular, Low-Gain
L

Left, High-Gain
Left Circular, High-Gain
M

Left, TV
Left Circular, TV Link
N

Right, Low-Gain
Right Circular, Low-Gain
R

Right, High-Gain
Right Circular, High-Gain
P

Right, TV
Right Circular, TV Link
Q

NOTE

Due to the qualifiers on the first character values of S and 1, the S frequencies are invalid with the Right Circular polarization codes, and the 1 frequencies are invalid with the Left Circular polarization codes.

Also note that although many other polarization options are available through the pull-down menu, only those shown in the table above are valid for Mutual Interference.




Datarate tables are another way of specifying the service details required by mutual interference processing. Values entered into the Datarate Table window, the pertinent portion of which is shown below in Figure 49-2, follow identical rules to those entered into the Communications Loading Parameters window.
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Figure 49-2. Mutual Interference Modeling with a Datarate Table
49.2.3
 seq head5 \r0 \h 

 seq head4 \r0 \h Schedule Separation Angle File

The final required piece, a Schedule Separation Angle File XE "Schedule Separation Angle File" \b , determines which interfering services are to be the subject of the mutual interference analysis. The file, shown below in Figure 49-3, consists of a header and rows of data, which follow a very unforgiving format.  It is recommended that an existing Schedule Separation Angle be edited to create a new one.  If, however, one must be created from scratch, use the following line for guidance:

-Mission~Name--199--LinkIDCode--Mission~Name--199--LinkIDCode---360.000

Dashes represent required spaces, while the remaining characters are placeholders.  Columns composed of alphanumeric characters are left justified, while numeric columns are right justified.
XPRIMARY MIS. COD#  SERVICE     2NDARY MIS.  COD#  SERVICE        ANGLE

 STS            11  1P192K000K  HST            21  MM004K032K     3.090

 STS            11  KP192K002M  LSAT4          31  KP085M015M      .180

 STS            11  KP192K002M  LSAT5          41  KP085M015M      .180

 STS            11  1P192K000K  TOPEX          51  SM016K512K     3.510

 STS            11  1P192K000K  EUVE           61  SM032K512K     3.550

 STS            11  1P192K000K  UARS           71  1P032K032K     2.980

 STS            11  1P192K000K  UARS           71  KP032K512K     3.560

 STS            11  1P192K000K  GRO            81  MM032K032K     3.070

 STS            11  1P192K000K  GRO            81  SM032K512K     3.570

 LSAT4          31  KP085M015M  STS            11  KP192K002M      .080

 LSAT4          31  KP085M015M  LSAT5          41  KP085M015M      .130

 LSAT5          41  KP085M015M  STS            11  KP192K002M      .080

 LSAT5          41  KP085M015M  LSAT4          41  KP085M015M      .130

 TOPEX          51  SM016K512K  EUVE           61  SM032K512K      .730

 TOPEX          51  SM016K512K  GRO            51  SM032K512K      .780

 EUVE           61  SM032K512K  TOPEX          51  SM016K512K      .440

 EUVE           61  SM032K512K  GRO            81  SM032K512K      .660

 GRO            81  SM032K512K  TOPEX          51  SM016K512K      .330

 GRO            81  SM032K512K  EUVE           61  SM032K512K      .530

 COBE           91  MM004K004K  HST            21  MM004K032K     1.610

 COBE           91  MM004K004K  TOPEX          51  MM016K016K     1.390

 COBE           91  MM004K004K  TOPEX          51  MM016K032K     1.390

 COBE           91  MM004K004K  TOPEX          51  SM016K512K     1.390

 COBE           91  MM004K004K  EUVE           61  MM001K032K     1.410

 COBE           91  MM004K004K  EUVE           61  SM032K512K     1.530

 COBE           91  MM004K004K  GRO            81  SM032K512K     1.600

 COBE           91  MM004K004K  ERBS          101  MM001K032K      .250

 COBE           91  MM004K004K  ERBS          101  SM001K128K      .250
Figure 49-3. Schedule Separation Angle File

Each row of data within this file represents a primary and secondary mission with explicit services types identified for each mission, and the maximum separation angle at which those services interfere.  The PRIMARY MIS. and 2NDARY MIS. columns contain names of coverage missions, while the COD# columns list coverage mission ID.  This information may be obtained from the Coverage Model window of the mission concerned. The SERVICE columns contain 10-character link codes, which identify the characteristics of the interfering services.  The first two characters of the code are identical to the frequency and polarization code (the “separation angle file code”) defined above.  The final 8 characters represent datarates, the first half being the I-channel datarate and the final half being the Q-channel datarate.  An individual datarate code consists of three digits, representing the integer datarate value, and a final letter, K or M, representing the datarate’s units, kilobits or megabits per second. Figure 49-4 has an example of the SERVICE column link code and the meaning associated with it.

S M 001M 000K


Figure 49-4. Example of a 10-Character Link Code
The ANGLE column contains separation angles in degrees to a maximum accuracy of 3 decimal places. The auxiliary Mutual Interference process compares angles defined in the Schedule Separation Angle File with calculated angles stored in the model’s Coverage Event Data (CED) to determine length of mutual interference time between services.

49.3
 seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Submitting

· In order to run successfully, the Mutual Interference program requires both coverage and schedule output. Consequently, it is necessary to have all such runs completed before its execution. The following must exist:

· Separation angle CED

· Station Services File

· Schedule Separation Angle File

Separation angle event data must be generated for all missions involved in the analysis. See the section on submitting CAS processes in Volume 3, Coverage Analysis, for details. The Station Services File is generated by Schedule.  When the Schedule run is submitted, verify that the Save SCHEDULE data files toggle is on, so that the file will be saved. Also at this time, associate a Schedule Separation Angle File with the model by entering the full path name of the file in the Schedule separation angle file: field at the bottom of the window.  This is necessary because the Mutual Interference process is not interactive, and will automatically use the Schedule Separation Angle File associated with the model for processing.  After the Schedule run completes, Mutual Interference can be submitted with the Submit/Schedule Analysis/Mutual Interference option of the NPAS Menu.


The Mutual Interference program is closely related to an exclusion option of the Schedule program.  In that option, contained in the Inclusion/Exclusion Options window, times of mutual interference are unavailable for scheduling to the interfering mission. Consequently, no information will be produced if the auxiliary Mutual Interference process is run on a mutual interference exclusion model.  To obtain meaningful results from the auxiliary Mutual Interference process with such a model, turn on the Suppress All Exclusion Data Processing Requests toggle in the Scheduling Control Options window prior to submitting the Schedule run.

49.4
 seq head5 \r0 \h 

 seq head4 \r0 \h 

 seq head3 \r0 \h Analyzing

After the process completes, the Mutual Interference Report XE "report:Mutual Interference" , Figure 49-5, can be viewed by selecting the View Report Now button from the informational dialog box.  Alternatively, use the Reports/Schedule Analysis/Mutual Interference option of the NPAS Menu, and select MUT_model.rpt, where model is the name of the current model. Through this option, another associated file, MUT_model.ft18, is available for viewing.  The first portion of this file is a listing of all calculated separation angle events, while the second, smaller portion lists explicit intervals of mutual interference for each service pair defined in the Schedule Separation File.  The summarized information in the Mutual Interference Report, however, is generally sufficient.


Figure 49-5. Mutual Interference Report
Each entry in the report provides results on the interference pairs defined in the Schedule Separation Angle File.  These results include the amount of mutual interference in minutes and by count, along with its impact on the primary mission.  The 12-character code listed as LINK corresponds to the 10-character code found in the SERVICE column of the Schedule Separation Angle File. The first four characters of the 12-character link code provide the same information as the first two characters (also known as the Frequency and Polarization code) found in the 10-character link code.  Tables 49-3 and 49-4 describe this correlation, while Figure 49-6 provides an example.

Table 49-3.  First and Second Characters of Link Code

Characters
F&P
Service
Frequency

MM
M
MA
2287.5 MHz 

SM
S
SSA
2287.5 MHz, Left Circular Polarization, MA Compatible

S1
1
SSA
2287.5 MHz, Right Circular Polarization, Non MA Compatible

S2
2
SSA
2217.5 MHz 

S3
3
SSA
2255.5 MHz

K1
K
KSA
15003.4 MHz

Table 49-4.  Third and Fourth Characters of Link Code

Characters
F&P
Polarization
Link Type

LL
L
Left Circular
Low Gain

LH
M
Left Circular
High Gain

LT
N
Left Circular
TV Link

RL
R
Right Circular
Low Gain

RH
P
Right Circular
High Gain

RT
Q
Right Circular
TV Link

  12-Character Link Code
  S M L H 001M 000K







                                                              S M 001M 000K
                                                                                                                           10-Character Link Code

Figure 49-6. Relationship between 10- and 12-Character Link Codes
The final portion of the Mutual Interference Report provides information on the total amount of mutual interference and its impact on the schedule as a whole.  Note that if an entry in the Schedule Separation Angle File has a reciprocal entry, the totals will not be correct, as the same instances of mutual interference will be counted twice.  A reciprocal entry simply means that the primary and secondary information is swapped.  An example follows:

STS            11  1P192K000K  HST            21  MM004K032K     8.090

HST            21  MM004K032K  STS            11  1P192K000K     8.090

Q-Channel: 0 Kilobits per second





I-Channel: 1 Megabit per second





Polarization: Left Circular + High Gain





Frequency: SSA 2287.5 MHz, MA Compatible User





Service: SSA





Frequency: 2287.5 MHz, MA Compatible User





Polarization: Left Circular





Link Type: High Gain, High Power





I-Channel: 1 Megabit per second





Q-Channel: 0 Kilobit per second

















           ****************************************************


           *                                                  *


           *         NPAS MUTUAL INTERFERENCE ANALYSIS        *


           *                                                  *


           *             VERSION 3.26  10NOV98 0943           *


           *                                                  *


           *        LIMITS: 199 MISSIONS AND 99 STATIONS.     *


           *                                                  *


           ****************************************************





                SPAN OF NPAS SCHEDULE RUN= 10080.0 MINUTES





   ACTIVE MM13 POS.#  1 MIS#= 164 BIAS=  1440 MINS. & COD MIS= STS         


   ACTIVE MM13 POS.#  2 MIS#= 150 BIAS=  1440 MINS. & COD MIS= HST 


        


PRIMARY MISSION NUMBER= 164  MISSION MODEL NAME= STS-KA      


                  M.I. ANGLE=  8.090 DEG. COD CED3 MIS#=  11


                  FOR SERVICE TYPE= SSAR LINK=S1RH192K000K


        SECONDARY MISSION NUMBER= 150  MISSION MODEL NAME= HST-SSAF    


                  FOR SERVICE TYPE= MAR  LINK=MMLH004K032K


                  ALTERNATE MM MIS#= 153 MM NAME= HST-SSAR    


                  ALTERNATE MM MIS#= 155 MM NAME= HST-MAR     





TOTAL PRIMARY MISSION MUTUAL INTERFERENCE TIME=  2076.9 MINUTES


      FOR PERCENT OF SPAN=  20.604%


TOTAL COUNT=    130 FOR AVERAGE AMOUNT OF M.I. OF  15.976 MINUTES


TOTAL PRIMARY SERVICE TIME=  9254.7 MINUTES & PERCENT M.I.=  22.442%





PRIMARY MISSION NUMBER= 164  MISSION MODEL NAME= STS-KA      


                  M.I. ANGLE=  4.360 DEG. COD CED3 MIS#=  11


                  FOR SERVICE TYPE= KSAR LINK=K1RH192K002M


        SECONDARY MISSION NUMBER= 160  MISSION MODEL NAME= LAND-4KSA   


                  FOR SERVICE TYPE= KSAR LINK=K1RH085M015M





TOTAL PRIMARY MISSION MUTUAL INTERFERENCE TIME=    20.7 MINUTES


      FOR PERCENT OF SPAN=    .205%


TOTAL COUNT=      5 FOR AVERAGE AMOUNT OF M.I. OF   4.140 MINUTES


TOTAL PRIMARY SERVICE TIME=  5552.4 MINUTES & PERCENT M.I.=    .373%
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